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1 Introduction

Template Builder is aweb application that allows journalists and content creators to edit and build
customized templates based on existing templates.

The templates can be customized with different functionalities described in this guide. The major
functionality in Template Builder is the possihility to add custom HTML panels to the forms used to edit
the templates which gives the user full control over the template.

1.1 Workflow

The basic workflow from graphics design to aworking template is as follows:

Scenes are made in Viz Artist. Multiple scenes can make up one template, categorized under
different variants.

Objectsin the scene, that the graphics designer wants to make editable in the finished template, are
given the appropriate control plugins.

Templates are made in Template Wizard, after importing the scene(s) over.

These templates are saved within the Pilot system and are available to the Template Builder.

In Template Builder atemplate can be opened, edited/customized and previewed.

Thetemplate is saved back into the Pilot system and are made avail able to the newsroom and control
room systems.

A journalist, editor or other content creator, fills the graphics template with content. This can
include: text, numbers, images, videos, websites and maps. The template is saved into the Viz Pilot
system creating a data element that is added to the newsroom story.



® The Viz Pilot operator monitors the newsroom playlist (rundown) and plays the graphics on-air at the
correct time in the broadcast.

Note: The changes made to atemplate in Template Builder will not be availablein the templatein
Template Wizard

1.2 Document Structure
This User's Guide is divided into the following chapters:
® |ntroduction

® Setup
® Using the Template Builder

1.3 Related Documents

The templates customized in Template Builder can be used by other Viz products like Viz Pilot Edge, Viz
Story and Viz Multiplay.

For more information about al of the Vizrt products, visit:

® www.vizrt.com

® Vizrt Documentation Center
® Vizrt Training Center

® Vizrt Forum

1.4 Customer Feedback and Suggestions

We encourage suggestions and feedback about our products and documentation.

To give feedback and, or suggestions, please identify your local Vizrt customer support team at www.vizrt.
com.

1. Click on Contact (top of page).

2. TheVizrt office which is nearest to your location will be shown, or select from the list of Vizrt
offices.

Click on the Contact button for the office you want.

Complete the required details in the window that open

5. A Vizrt representative will contact you as soon as possible.

W

Note: If this messageisfor Customer Support, and there is a Support Contract in place, then
click on the ‘ For support requests, please visit our support portal’ link in the message window.
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1.5 Customer Support Requests

Support Requests are supported by Vizrt if customers have avalid Service Agreement in operation.
Customers who do not have a Service Agreement and would like to set up a Service Agreement should
contact their regional sales representative (see Customer Feedback and Suggestions).

When submitting a Support Request, relevant and correct information should be given to Vizrt Support, to
make sure that Vizrt Support can give the quickest and best solution to your Support Reguest.

This section contains the following topics:

® Before Submitting a Support Request
® Submitting a Support Request

1.6 Before Submitting a Support Request

Before a Support Request is submitted make sure that you:

Read:

® Therelevant User Guide or Guides
® Therelease notes
and Check:

® That the system is configured correctly
® That you have the specified hardware, tested and recommended versions
Always refer to your Vizrt Service Level Agreement document.

1.7 Submitting a Support Request

When completing a Support Request, add as much information as possible.

1.7.1 Content of a Support Request

The report should contain information about these topics:

® Problem description: Include a good description of what the problem is and how to reproduce it.
Specify your workflow. Remember to use simple English.

® Screen shotsand illustrations: Use these to simplify the message. These are extremely useful for
Vizrt Support.

® Software configuration: Add exact versions of software used. Thisis extremely important
information. The version information is available in the log.

® System log files: Send the system log file. Y ou can save your log file in the link to Logs pane.

® System locale: Specify the Region and Language settings of the system.

® Hardware configuration: Add exact versions of hardware used, especialy for Viz Engine.
Optional:

® System setup: Describe differencesin the instalation, if any, from the recommended setup.



® System Network: Add a description of how the network, bandwidth, routers, and switches are
configured.
Always refer to your Vizrt Service Level Agreement document.

1.7.2 To submit a Support Request:

arwbdE

On the www.vizrt.com page, click on Support.

Click on Report a case.

Click on LOG IN tologin to the Customer and Partner portal.

At the top of the Case Management page, click on Report a Case.

In the online form complete the required minimum information (shown by ared asterisk) and click
SAVE.

In the saved Support Case that opens, complete the various text boxes and upload any required
documents, files, etc. (see Content of a Support Request).

To track the status of open support tickets, login to the Customer and Partner portal. Add
information or communicate about the cases directly with the support team.


http://www.vizrt.com/

2 Setup

The Template Builder follows the Pilot Data Server installation and opens as aweb application in a
browser.

The URL to access Template Builder is:

http:// pds- host-name: 8177/t enpl at ebui | der

2.1 Graphic Hub Connection

If Graphic Hub functionalities are needed to specify default values for geometries, materials, video, image
and font fields, a Graphic Hub URL address must also be provided:

http:// pds-host-nane: 8177/t enpl at ebui | der ?gh=ghhost



3 Using the Template Builder

This section will explain the user interface of the Template Builder and how to useit.

In addition to a brief overview of the user interface below, the following topics are explained in more

detail:
The Template Builder Window
TheFill In Form

The Preview Window

3.1 Open a Template

Template Builder isatool for editing and customizing existing templates.

From the main user interface, select the Open button to browse for an existing template available within

the Pilot system.

In the Open Template diaog, browse the desired template by selecting CONCEPT and TAGS. The
template search can be narrowed down by searching for the template name in the Typeto filter... field at

the top.
Open Template
h

CONCEPT TEMPLATES

(All tem

—
—_—

TAGS
ImageFull

LowerThird

(All categories)
(Uncat

Basic

Orange

Vibrant

3linesBIGCenter

linesBIGCenterMNEW

3.2 Main User Interface

The main user interface is divided into three main windows.



(1) The Template Builder Window
(2) TheFill In Form
(3) The Preview Window

The Preview Window (3) provides snapshots of the graphics with content. The preview snapshots provide
the user with an idea about how the graphics will look like when played on air and are updated as changes
are being made in the Fill In Form (2). In the Fill In Form the user fills in/edits content for the graphics.
The field information, exposed fields and layout in the Fill In Form can be customized by the user in the
Template Builder (1).

RESTORE

OT LOWERTHIRD

LINE 01
LINE 02

1

Label

Tip text

Read-only

Hidden

3.3 Save

Saving, , changes made to an open template in the Template Builder will overwrite the templatein
the Pilot Data Server.

3.4 Restore

The restore button, sl Will undo all changes since the last save.

3.5 About

Clicking the Template Builder logo _ in the top left corner of the application takes the
user to the about page.

Here isinformation about software version, link to local documentation and link to third party licences.
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3.6 Template Preparation

The current version of Template Builder relies on templates being generated and organized using Viz
Pilot's Template Wizard. The following procedures will give you a quick introduction on how to create
and manage a template. For more information on how to work with Template Wizard, please see the Viz
Pilot User's Guide.

3.6.1 Creating a Template

=123 12 (Lower Third SUBTITLE)

Bz CSubtitle: il
ZZ|Add subtitle of the story =

------------------------- o T B

Tag:
<MNone=

The following procedure explains how to create and save a template.

To create atemplate:

Start Template Wizard

Connect to your Viz Engine

On the File menu, select Wizard

Drag and drop the scene to the Selected Scenes pane (right)
Click Finish

On the File menu, select Save (Ctrl+S)

Enter a Template name

Select a Concept name (or create a new)

Click Save as New

©OoNOOAWNE

3.6.2 Managing Concepts and Variants

Concepts - ALL Concept ten a5 \ .

=] Third v Lower
Upper

o | oo R T e

e o || e |
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The following procedures explain how to organize a template for use with more than one concept and
variant, for example a Blue and Red concept with alower and upper third graphic. As aprerequisite all
scenes should have the same type of datain order to use the same template.

To manage concepts:

On the Tools menu, select Template Manager

Under the Concepts - All pane, click New

Enter aname for the new concept and save it

Open the other concept

Drag and drop the template from the old to the new concept (and confirm the operation)
Open the new concept

Edit the template by selecting the correct Scene folder for your new concept

Save and confirm the operation

© N U AMWDNE

To manage variants:

On the Tools menu, select Template Manager
Select your concept, then the template

Under the Template variants pane, click New
Enter a Description of the variant

Select the Scene name that is a variant of the other
Save and confirm the operation

oA~ wbdhE

3.7 The Template Builder Window

The Template Builder window is located to the left in the window and is where al the customization of
the template is done.

3.7.1 Settings

At the top of the Template Builder Window a Settings drop down list is available, which allows for the
following template settings:Limit With Choice Option

Duration

The duration setting can be used to specify the duration of the item. A default value is used when
unspecified. Minimum and maximum duration values may also be specified. If these are set to the same
number the item will get afixed duration.

OT LOWERTHIRD Settings | Duration

DURATION SETTINGS
Default : Minimum - Maximum :

12



Track

Setting a Name in the track settings allows for grouping of graphicsin the timeline editor, see Track
settings displayed in the timeline editor. The Index sets the position of the group in the timeline editor,
where 0 is the lowest position.

OT LOWERTHIRD

TRACK SETTINGS
MName

Track settings displayed in the timeline editor

Title generation

Thetitle generation setting allows for auto-generation of the title. Thetitle can for example be text with a
placeholder for aField ID. The placeholder isthe {field ID path}. An example is shown below:

LOWERTHIRD 5 : Title genera..| ¥ iz Default Values

TITLE GENERATI SETTINGS

LINE 01
LINE (
Lowerthird

3.7.2Field Tree

Each linein the Field Tree displays the ID and the label of afield in the template. It also contains an icon
indicating the type of the field.

13



VERTHIRD

/ariant-choice
ot

LINE 01
LINE 02

OT LOWERTHIRD Settings : |None v H=' Default Values Editall Show all

Field ID
¢ -concept-variant-choice

a
v
concept

variant LINEOT : 4 of 22 used.
LINE 01 Name

LINF 02 11 of 33 used.

The Field listing can be rearranged by drag-and-drop within the Field list.

Right clicking afield alist of choices appear. From here fields can be added/removed, HTML panel can
be added, Field ID can be changed and the selected field can be del eted.

The Fill In Form will alwaysimmediately update upon any change.

OT LOWERTHIRD

Field ID
-concept-variant-choice
concept
ELEL

Add field before LINE 01

Add field after LINE 02
Add child field Lowerthird

Add HTML panel before
Add HTML panel after

Change 1D of field

Delete field
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Each field line can be customized using a set of properties which are displayed in the bottom half of the
Template Builder window. Mark the desired Field in the top window, and the following properties can be
Set:

Label :

Tip text :

Read-only :

Hidden :

Label
Specifiesthe label of the field in the Fill In Form.

Tip text
A tool tip text can be entered to give more information about the field.

Read only
Selecting the Read-only check box will keep the field visible, but greyed out in the Fill In Form.

Hidden
Selecting the Hidden check box will hide the field in the Fill In Form.

Type
Thetype of content allowed in thefield in the Fill In Form are set using the drop down list under Type.
Depending on the type selected different choices are available:

Type Icon Description

Empty . Will make the field unavailable.
Typically used as a contained for
other fields.

15



Type

Icon

Description

Plain text

Thefield isatext field.

Max length: Set the number of
maximum charactersin the field.

Limit with choice.

Normalized text

Normalized text.

Max length: Set the number of
maximum charactersin the field.

Limit with choice.

Formatted text

A text that allows formatting.

Max length: Set the number of
maximum charactersin the field.

Single-line: Check this box to
specify that the rich-text editor
should only alow oneline of text.

Limit with choice.

Boolean

Creates a check box which have two
states; true and false.

Limit with choice .

I nteger

Thefield isan integer field.

Minimum: Set the minimum value
allowed.

Maximum: Set the maximum value
allowed.

Limit with choice .

Decima

The field allows decimal numbers.

Minimum: Set the minimum value
allowed.

Maximum: Set the maximum value
alowed.

Limit with choice .

Date and time

Use the Date Chooser inthe Fill In
Form to select date and time in this
field.
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Type

Icon

Description

Limit with choice .

Two numbers (duplet)

Thefield allows two numbers
(decimal numbers are allowed).

Minimum: Set the minimum value
allowed for both numbers.

Maximum: Set the maximum value
alowed for both numbers.

Limit with choice .

Three numbers (triplet)

Thefield allows three numbers
(decimal numbers are allowed).

Minimum: Set the minimum value
allowed for all three numbers.

Maximum: Set the maximum value
allowed for all three numbers.

Limit with choice .

Image

Will make the field available for an
image.

Limit with choice .

Video

Will make thefield available for a
video.

Limit with choice .

Font

fiL}

Will make thefield available for a
font.

Limit with choice .

Geometry

Will make the field available for a
geometry.

Limit with choice .

Materia

Will make thefield available for a
material.

Limit with choice .

Map

Will make the field available to
present and edit a map.

Limit with choice .

Custom

17



Type Icon Description

Using the custom type the media-
and X SD- type can be freely
specified.

Limit with choice.

List m Thereis not support for making lists
in Template Builder, but lists can be
available in the template from
Template Wizard.

Note: The user must be aware of the control plugins that have been exposed by the scene designer in
Viz Artist.

3.7.3 Limit With Choice Option

All the available content typesin the drop down list in the Template Builder Window have a check box
option called Limit with choice. The purpose of limiting the choice of afield isto makeit easier and less
error proneto fill in the right content when present in a drop down list.

An example where the Limit with choice functionality can be useful is when a Control Object moving
(Omo) plugin is accessible in the template. Scenes using Omo plugins will originally be presented as
integer values for the different elementsin the Fill In Form. The Limit with choice option can assign text
to these values to make it easier to select the right element.

An example of how this can be done in the Template Builder is explained below. In this example thereisa
scene that can be displayed at the top, in the middle or at the bottom in the graphics. For the Omo plugin
these positions correspond to the values 0, 1 and 2 respectively. To assign text to these values, do the
following:

® Mark the Omo Field ID in the Template Builder.

® Sdlect the Limit with choice option.

® When clicking on the Alter natives button, a new window appears. Right click to design the table by
inserting or removing rows. Click in a selected row or press F2 to do inline edits.

18



default

Tip text :

Read-only :

Hidden :

Ty

Minimum -

Maximum :

Choice label :

Use sub-chaoices

Alterr

® Doubleclick the table or press Return to insert Name, Tip and Value. Click Next, tab or Ctrl +
down, to continue filling the table.
Edit &

Previous

°
Editing List Alternatives
MName Tip Value

Top Graphic displayed at the top 0

Center Graphic dispalyed at the center 1

Bottom Graphic displayed at the bottom

19



® The Omo field in the Fill In Form now contains a drop down list containing the alternatives created
above as text, as oppose to an integer field where the user would have to remember which integer
corresponds to which position.

Default Values Editall Show al

LINEOT :

11 of 33 used.

Use Sub-Choices

Selecting the Limit with choice option, a new check box is made available called Use sub-choices. This
functionality allows the set-up of severa sub-choices for each choice.

For example, if the choices list different countries, sub-choices could list citiesin each of the countries.
See example below:

® Mark thedesired Field ID in the Template Builder.
® Select both Limit with choice and Use sub-choices options.
® When clicking on the Alter natives button, a new window appears. Right click to insert or remove

rows.
Editing List Alternatives - X

Narr Sub-choic abe Sub Alternatives

default

Limit with choice :

Choice label

Use sub-choices :

Alte

® Double click the table to insert Name, Tip and Sub-choice L abe whichin this caseis Cities.

20



Click the Sub Alter natives button to add the sub aternatives.

Editin Iternatives

Name Tip
Shanghai
Beijing
uit name
Guangzhou

Exit the tables when they are filled out.

Instead of atext field in the Fill In Form, the field now contains two drop down lists; the main
choices, which in this caseisalist of countries, and sub-choices with corresponding cities.

ies Default Values Editall Show all
Variant :
T
v

4 of 22 used.

Shanghai
Beij

21



3.7.4 The HTML Panel

As a part of the customization workflow the user can add an HTML panel to the template, whichisa
functionality that gives the user full control over the template by using custom scripting and logic to build
the template. The template can host a webpage by entering aweb address in the Template Builder.
Normally the aim is not to host a single webpage, but rather make a data integration HTML template.

A simple example showing how to connect a custom HTML template to a pilot template is shown below.
Keep in mind that this example shows a limited possibility of what can be done using the customized
workflow. Using it in more advanced ways opens up to possibilities where the user has 100% control over

the template.

Add HTML panel

The option of adding aHTML panel is available by right clicking in thefield ID list in the Template
Builder window. Selecting the HTML panel field ID, its properties become available in the bottom

window.

The size of the HTML panel shown in the Fill In Form is set in the Height field.

In the Source URL type in the web address.

The Hidden fields drop down list allows the user to hide available fields in the Fill In Form.

Custom HTML template

Using the custom HTML template opens up to full user control of the template using custom scripting and

custom logic.

The following example will show how to create a simple custom HTML template in Template Builder.

In this example we are working with a simple custom html template showing the message Hello world

when opened in a browser:

3 Custom HTML Templats X

Hello world

< C | O pilotdataserver:8177
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How to see the custom HTML template inside Template Builder

® Open atemplate in Template Builder and add an HTML panel to the template as explained above
® |nthe URL field enter the URL of the custom html template
Now the message Hello world should appear in the Fill In Form:

OT LOWERTHIRD : Default Values Editall Showall Refresh HTML

Field ID
-concept-variant-choice

LINE 01

LINE 02
storylayer Lowerthird
99

Hidden fi

How to connect the custom HTML template to the pilot template

Following the example above, it is how ready to establish atwo-way communication, or bind fields,
between the HTML template and the opened pilot template. A new field is therefore added to the
template:

® Right-click on your HTML panel field, and choose Add field after
® Giveittheid 50
® Changethefieldstypeto Plain text

23



® A new field appears:

Editall Showall Refresh HTML panels

t-

LINE 01
LINE 02
storylayer Lowerthird
99
50

Limit with choice :

To connect the custom html template to the newly created field, the custom HTML templateis opened in
an editor.

The payloadhosting.js file must be included in the HTML template. Thisfileislocated in the jsfolder in
the template builder folder.

Theentire<body> block is replaced with:

<body onl oad="vi zrt. payl oadhosting.initialize()">
<l abel for="field 50">My input field:</label>
<i nput nanme="field 50" type="text" id="field_50">
</ body>

Saving the html file and clicking Refresh HTML panels, reloads the custom html template with the
changes just made. Now a bi-directional connection between the editor and the custom template have been
established. When typing either inside the template or inside the field with id 50, both fields should be
updated at the same time. Thisway of binding fields will work for any HTML fields that have value
support, which istypically <i nput > typesand <t ext ar ea>.

24



Default Values
Field ID
-concept-variant-choice
concept
variant

01 LINE 01
02

storylayer
99

=5 The custom template is upda

mple. htm

Hidden fields :

Addingthe i d="fi el d_50" to the <input> element inside the HTML templateis all that is needed for
the two-way communication to be set up, since we added a field with theid of 50. Any amount of these
binding fields can be established the exact same way; the way they are mapped are viaid.

This gives asimple way of setting up abinding field. Note that updating the <i nput > elements
programmatically will still send data back and forth; which is great for automated data integration such as
fetching live sports data.

Note: To prevent two editors for the same field being visible at the same time, use the Hidden fields
setting inside the HTML panel settings.

Browser Caching

The user might experience browser caching behavior when trying to update and display changesin the
custom HTML template in Template Builder. Thisis standard browser behavior and Template Builder
does not have control over caching resources that the HTML file itself includes.

To prevent this browser behavior, following actions can be made:

1. Make surethe URL's to the resources are unique upon reload.

25



2. The web server serving the resources could be configured to send Expiry headers set to 0. More
detailed information on how caching works and how to modify these is out of scope for this
documentation

3. Disable caching on the browser side. Thisis done differently per browser.

3.8 TheFill In Form

The window placed in the middle in the Template Builder is the auto generated fill in form for the
graphics. It displays editable fields that are given the appropriate control plugins by the designer in Viz
Artist where the user can add content to the graphic. What type of content that are allowed in the fields are
controlled in the Template Builder Window. Fields can be restricted to contain e.g. only text with acertain
amount of characters, numbers within a specific range, media placeholders for media assets, or it can be a
set of choicesin adrop-down list.

Aslong asthefieldsin the Fill In Form are exposed controls made by the designer the added content will
be shown in the Preview Window .

Default Values Editall Show all Refresh HTML panels

y Landscape Grey s

4 of 30 used.

Limit with choice :
Top

Date and Time :

01714 [

Mo Image set.

At the top of the Fill In Form there are three options Edit all, Show all and Refresh HTML panels.

Edit all isan option to edit all fieldsin the Fill In Form. Thisisto provide away to edit default values of
fields that are set to read-only.

Selecting Show all displays al fieldsin the Fill In Form, even if the fields are set in hidden mode.

Selecting Refresh HTML panelswill reload the HTML panel(s) in the Fill In Form.

26



3.9 The Preview Window

The Preview Window islocated to the right in the Template Builder, which displays snapshots of the final
output in an ongoing preview process, providing the user an idea about the how the graphics will ook like
when played out in high resolution on aViz Engine.

The Template Builder sends requests to the Preview Server which manages Viz Engines that provides the
snapshots.
-

™ Graphics Preview

ql\rlzrt"' Mame

Age

Auto-refresh :

The toolbar at the bottom of the Preview Window alows you to adjust how to view the preview of the
element graphics:

® TA: Show/hidethe Title Area

® SA: Show/hide the Safe Area

® K: Show the key signal for the graphics

® Scrub the timeline back and forth using the slider.

The user can scrub the timeline of the graphic located at the bottom of the Preview Window by clicking on
it. If the graphic contains stop points these will be marked on the timeline.

27



3.9.1 Auto-refresh

Auto-refresh islocated at the bottom of the Preview Window and is by default toggled on which means
that the Preview Window updates once there are any changes in the Properties Editor.

Toggle off Auto-refresh to turn this functionality off. To refresh the Preview Window in this mode click

C Autorefresh: ]

the Refresh button or click inside the Preview Window.
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